TI Designs

EtherCAT® Interface for High Performance C2000™ MCU

Description
This reference design demonstrates how to connect an EtherCAT ET1100 Slave Controller to a C2000 Delfino™ MCU. The interface supports both demultiplexed address/data busses for maximum bandwidth and minimum latency, and a serial peripheral interface (SPI) mode for low pin-count EtherCAT communication. The Slave Controller offloads the processing of 100 Mbps Ethernet-based fieldbus communication, thereby, eliminating CPU overhead for these tasks.

Features
• High-Performance Real-Time Control MCU Paired With Low-Latency Ethernet-Based Communication
• High-Bandwidth, Low-Latency Interface to Beckhoff ET1100 EtherCAT Slave Controller
• Supports Both Asynchronous Parallel and SPI Connections
• Glueless Interface
• Eliminates CPU Overhead for EtherCAT Frame Processing

Applications
• Industrial Drives
• Servo Motor Drives
• Manufacturing Robotics
• CNC Machinery
• Remote I/O

Resources
http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT
TMS320F28377D Design Folder
DP83822 Product Folder
LAUNCHXL-F28377S Product Folder

Features
• High-Performance Real-Time Control MCU Paired With Low-Latency Ethernet-Based Communication
• High-Bandwidth, Low-Latency Interface to Beckhoff ET1100 EtherCAT Slave Controller
• Supports Both Asynchronous Parallel and SPI Connections
• Glueless Interface
• Eliminates CPU Overhead for EtherCAT Frame Processing

Applications
• Industrial Drives
• Servo Motor Drives
• Manufacturing Robotics
• CNC Machinery
• Remote I/O

Resources
http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT
TMS320F28377D Design Folder
DP83822 Product Folder
LAUNCHXL-F28377S Product Folder
1 System Overview

1.1 System Description

The TIDM-DELFINO-ETHERCAT TI design describes a pair of plug-in modules that use a Beckhoff ET1100 EtherCAT Slave Controller (ESC) and TI Ethernet PHYs to enable the creation of EtherCAT slave nodes, when coupled with a C2000 MCU. The modules are available in both daughtercard format (for TI F2837x ControlCARDs) and in BoosterPack™ format (for C2000 LaunchPad development kits). The daughtercard format uses a 60-pin high-density connector that can support both asynchronous parallel and SPI interfaces, while the BoosterPack format utilizes a standard 40-pin header and supports a SPI interface only.

This TI design illustrates how to set up the EtherCAT BoosterPack and daughtercard modules, initialize the ET1100 subsystem for first use, and install and configure the Beckhoff TwinCAT 3 software for use as an EtherCAT master in a test setup. Example code is provided to configure both SPI and EMIF interfaces and run simple read/write tests across an EtherCAT network.

![Figure 1. TIDM-DELFINO-ETHERCAT BoosterPack Plug-in Module and C2000 Launchpad](image)

1.2 Key System Specifications

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
<th>VALUE</th>
<th>DELAY</th>
</tr>
</thead>
<tbody>
<tr>
<td>TA</td>
<td>Read-to-Write Turnaround time</td>
<td>1</td>
<td>5 ns</td>
</tr>
<tr>
<td>RHOLD</td>
<td>Address and CSn hold after OEn LH edge</td>
<td>1</td>
<td>5 ns</td>
</tr>
<tr>
<td>RSTROBE</td>
<td>Read Strobe time in units of EMIF Clocks</td>
<td>64</td>
<td>320 ns</td>
</tr>
<tr>
<td>RSETUP</td>
<td>Address and CSn to OEn assertion delay</td>
<td>1</td>
<td>5 ns</td>
</tr>
<tr>
<td>WHOLD</td>
<td>Write Hold time after WE deassertion</td>
<td>1</td>
<td>5 ns</td>
</tr>
<tr>
<td>WSTROBE</td>
<td>Write Strobe (WE) width</td>
<td>2</td>
<td>10 ns</td>
</tr>
<tr>
<td>WSETUP</td>
<td>Address and CSn setup time to WE assertion</td>
<td>1</td>
<td>5 ns</td>
</tr>
<tr>
<td>EW</td>
<td>Extended Wait Mode</td>
<td>ENABLE</td>
<td>-</td>
</tr>
<tr>
<td>SS</td>
<td>Strobe Select Mode</td>
<td>DISABLE</td>
<td>-</td>
</tr>
</tbody>
</table>

Table 1. EMIF Configuration and Timing Settings for ET1100 PDI
(1) F2837x system with Fsysclk = 200 MHz.

Figure 2. EMIF PDI Timing Diagram

1.3 Block Diagram

Figure 4 shows the block diagram of the SPI (for the C2000 LaunchPad) and EMIF (for the C2000 ControlCARD) interfaces. In both configurations, the F2837x runs the EtherCAT slave stack while the ET1100 is used to offload the EtherCAT Slave Controller (ESC) frame processing, FMMU, and SyncManager operations.

Certain pins on the ET1100 are used on both the SPI and asynchronous interfaces, which requires the 74CBTLV3257 mux and 74CBTLV3245 buffer to steer these signals to the appropriate GPIO on the F2837x MCU.

The EtherCAT BoosterPack and Add-on cards feature an on-board DC-DC 5V–3.3 V converter, which allows the 3.3 V Vcc to be sourced from either the C2000 LaunchPad/ControlCARD, or generated locally from an off-board 5V source.

Figure 3. Block Diagram
1.4 **Highlighted Products**

1.4.1 **TMS320F28377D**

The Delfino TMS320F2837x is a powerful 32-bit floating-point microcontroller unit (MCU) designed for advanced closed-loop control applications such as industrial drives and servo motor control; solar inverters and converters; digital power; transportation; and power line communications. Complete development packages for digital power and industrial drives are available as part of the powerSUITE and DesignDRIVE initiatives. The F2837x supports a new dual-core C28x architecture that significantly boosts system performance while integrated analog and control peripherals allow designers to consolidate control architectures and eliminate multiprocessor use in high-end systems.

In the TIDM-DELFINO-ETHERCAT design, the F2837x receives EtherCAT data from the ET1100 through either a serial (SPI) interface or an asynchronous parallel memory interface (EMIF). **Figure 5** shows the use of EMIF2, but either EMIF can be used to interface to the ET1100. Note that GPIO93,94 are for future expansion to address a larger memory space. They are not used in the example code.
1.4.2 **DP83822**

The DP83822 is a low power single-port 10/100 Mbps Ethernet PHY. It provides all physical layer functions needed to transmit and receive data over both standard twisted-pair cables or connect to an external fiber optic transceiver. Additionally, the DP83822 provides flexibility to connect to a MAC through a standard MII, RMII or RGMII interface.

1.4.3 **TPS62063**

The TPS6206x is a family of highly efficient synchronous step-down DC-DC converters. They provide up to 1.6-A output current. With an input voltage range of 2.7 V to 6 V, the device is a perfect fit for power conversion from 5-V or 3.3-V system supply rails. The TPS6206x operates at 3-MHz fixed frequency and enters power save mode operation at light load currents to maintain high efficiency over the entire load current range. The power save mode is optimized for low-output voltage ripple. For low noise applications, the device can be forced into fixed frequency PWM mode by pulling the MODE pin high.

In this TI Design, the converter enables power to be supplied from either the C2000 LaunchPad, controlCARD, or from an external 5 V source.
1.4.4 **SN74LVC1G07**

This single buffer/driver is designed for 1.65-V to 5.5-V \( V_{CC} \) operation. The output of the SN74LVC1G07 device is open drain and can be connected to other open-drain outputs to implement active-low wired-OR or active-high wired-AND functions. The maximum sink current is 32 mA.

In this design, the open-drain buffer connects a GPIO from the F2837x LaunchPad or controlCARD to the ET1100 EtherCAT slave controller reset pin, thereby, enabling independent reset of both devices.

1.4.5 **SN74CBTLV3245A**

The SN74CBTLV3245A provides eight bits of high-speed bus switching in a standard '245 device pinout. The low on-state resistance of the switch allows connections to be made with minimal propagation delay. The device is organized as one 8-bit switch. When output enable (OE) is low, the 8-bit bus switch is on, and port A is connected to port B. When OE is high, the switch is open and the high-impedance state exists between the two ports.

In this TI Design, the bus switch isolates selected ET1100 outputs from the F2837x controlCARD GPIOs when the EMIF interface is not used (SPI mode). Note that the bus switches are optional in a design using only a single interface type.

1.4.6 **SN74CBTLV3257**

The SN74CBTLV3257 device is a 4-bit 1-of-2 high-speed FET multiplexer/demultiplexer. The low on-state resistance of the switch allows connections to be made with minimal propagation delay. The select (S) input controls the data flow. The FET multiplexers/demultiplexers are disabled when the output-enable (OE) input is high.

This multiplexer connects selected GPIOs to the ET1100 depending on the interface mode (EMIF or SPI). Note that the multiplexer is optional in a design using only a single interface type.

1.4.6.1 **Beckhoff ET1100 EtherCAT Slave Controller (ESC)**

The ET1100 device is an EtherCAT Slave Controller (ESC). It handles all communications between the EtherCAT fieldbus and the F2837x interface (either SPI or EMIF).

For more information, see [http://www.beckhoff.com](http://www.beckhoff.com).
Figure 7. TMS320F2837x Functional Diagram
1.4.8 Ethernet PHY Functional Diagram

![Ethernet PHY Functional Diagram]

Figure 8. DP83822 Functional Diagram

1.4.9 SN74CBTLV3245A Functional Diagram

![SN74CBTLV3245A Functional Diagram]

Figure 9. SN74CBTLV3245A Functional Diagram
1.4.10 SN74CBTLV3257 Functional Diagram

Figure 10. SN74CBTLV3257 Functional Diagram

1.4.11 ET1100 Functional Diagram

2 Getting Started Hardware

This TI-Design describes two configurations for the EtherCAT plug-in: a BoosterPack form factor compatible with TI LaunchPad Development kit and a F2837x ControlCARD daughtercard. The hardware setup described below is identical for both configurations in terms of EtherCAT connectivity and slave operation. The available Process Data Interfaces (PDIs) differ between the two boards, in that the LaunchPad has only enough pins for a SPI connection, whereas, the controlCARD plugin can support either an EMIF or SPI interface.

![Figure 11. Stacked F2837x LaunchPad and EtherCAT BoosterPack (Left) and ControlCard + EtherCAT Plugin (Right)](image)

2.1 EtherCAT Master Configuration Using TwinCAT3

2.1.1 Download and Install TwinCAT3 From the Beckhoff website

The TwinCAT3 software is available from the Beckhoff website at [http://www.beckhoff.com](http://www.beckhoff.com). Follow the left sidebar to Download → Software → TwinCAT 3 → TE1xxx | Engineering. As of this writing, the most recent version of this software is TwinCAT 3.1 – eXtended Automation Engineering (XAE) v 3.1.4018.26.
2.1.2 Verify the TwinCAT Runtime is Active

1. Check for the EtherCAT icon in the notification panel in the lower-right corner as shown in Figure 13. If this is absent, open the notification panel and check in the popup window for the TC Switch Runtime. Right click on this icon and select Tools → TC Switch Runtime.

![Figure 13. TwinCAT Runtime Icon in Windows Toolbar](image)

2. Verify that the TC Switch Runtime is active. The “Deactivate” button should be showing as illustrated in Figure 14. If this button reads “Activate”, click that button to start the TC Switch Runtime.

![Figure 14. TwinCAT Runtime Dialog Box](image)

3. If the TC Switch Runtime is not found in step (a,b) above, then locate the runtime in the file system. A typical location is: “c:\TwinCAT\TC Switch Runtime\TC Switch Runtime.exe”. Note that it is NOT commonly found in the Start Menu.

2.2 Start TwinCAT3 and Verify That TwinCAT is Running in Visual Studio

1. Locate the TwinCAT XAE, which can be found in one of three places:
   (a) Start menu → under Beckhoff → TwinCAT3 → TwinCAT XAE (VS 2010).
   (b) Desktop icon is shown in Figure 15.

![Figure 15. TwinCAT3 XAE Desktop Icon](image)
Getting Started Hardware

(c) Notification panel icon → right click and select TwinCAT XAE (VS 2010).

Figure 16. TwinCAT3 Icon in Toolbar

2. Verify that TwinCAT is running under Visual Studio. “TwinCAT” and “PLC” should both appear in the main toolbar as shown in 1. If these menu items are not shown, then the TC3 runtime is NOT running. Go back to step Figure 17 to restart the TC3 runtime.

Figure 17. Visual Studio Menus for TwinCAT3

3. Open a new EtherCAT project.
   (a) File → New → Project.

Figure 18. TwinCAT3 New Project Dialog
4. Verify that a Realtime Ethernet Adapter is installed.
   (a) TwinCAT → Show Realtime Ethernet Compatible Devices
   If no RT adapter is installed, select one from the list of Compatible devices and click “Install”, then exit this popup.

5. Scan for the newly installed Realtime adapter by clicking TwinCAT → Scan.
   (a) A popup indicating TwinCAT has found the adapter that should appear (see Figure 20).

   Figure 19. TwinCAT3 EtherNet Adapter Dialog

   (b) Click “OK”, then click “Yes” to the following two popups (see Figure 21).

   Figure 20. TwinCAT3 Discovery of Ethernet Adapter

   Figure 21. TwinCAT3 Master Scan for Slaves and Free Run Activation
(c) The screen view shown in Figure 22 should now be visible in TwinCAT3, indicating that the Master and Slave are connected and prepared for use. Note that “Box 1 (TI_C2kESC)” appears at the bottom of the image, indicating that TwinCAT has discovered the EtherCAT slave. If this is the first time that the slave has been connected and the EEPROM has not yet been programmed, the “Box n ()” label (for example, “TI_C2KESC”) will not be visible.

Figure 22. TwinCAT Solution Explorer Showing EtherCAT Master (Device 2) and Slave (Box1, TI_C2kESC)

6. The EtherCAT Master is now ready for communication with the Slave device.
### 2.3 Configuring the EtherCAT BoosterPack Interface for EMIF or SPI Operation

The EtherCAT BoosterPack board must be configured prior to powerup to select between the EMIF or SPI interface from the C28x to the ET1100 slave controller. Options for power source and interface type are available through jumpers and/or DIP switches as described in Figure 23 and Table 2.

*Figure 23. EtherCAT BoosterPack LED and Switch Locations (Switch and LED locations are identical for the ControlCard plugin version)*

<table>
<thead>
<tr>
<th>Name</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Switches/Jumpers</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SW1</td>
<td>L – SPI</td>
<td>Selects between EMIF and SPI Interface Modes</td>
</tr>
<tr>
<td></td>
<td>R – EMIF</td>
<td></td>
</tr>
<tr>
<td>J3</td>
<td>1-2 off-board</td>
<td>Off-board: 3.3 V is provided directly from attached LaunchPad or ControlCARD</td>
</tr>
<tr>
<td></td>
<td>2-3 on-board</td>
<td>On-board: 3.3 V is generated by the on-board regulator from a separate 5 V</td>
</tr>
<tr>
<td></td>
<td></td>
<td>supply.</td>
</tr>
<tr>
<td><strong>LEDs</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUN LED</td>
<td>State Machine Status [1]</td>
<td>Off: ET1100 Device is in INIT state. On: ET1100 Device is in Operational</td>
</tr>
<tr>
<td></td>
<td></td>
<td>state.</td>
</tr>
<tr>
<td>DS2/PWR LED</td>
<td>3.3 V Power</td>
<td>ON indicates 3.3 V is being supplied to the board. For details, see the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>schematics in Figure 38.</td>
</tr>
</tbody>
</table>

2.4 Preparing the Addon Board for EtherCAT Communication Using TwinCAT3

After installing the TwinCAT3 software in the previous section and verifying connectivity between the EtherCAT Master and the slave node, the ESC EEPROM must be programmed to enable communication to the C28x device over either the EMIF or SPI PDI. The following procedure writes the binary file associated with the selected PDI type into the EEPROM:

1. After starting up the TwinCAT software in Section 2.1, the screen should look something like Figure 24. Double clicking the EtherCAT slave (labelled “Box 1” in the figure) brings up the EtherCAT properties window on the right. Click “Advanced Settings”.

![Figure 24. TwinCAT Project EtherCAT Tab](image)
2. In the advanced settings popup windows, select “Smart View” to bring up detailed information about the EtherCAT Slave PDI. Click “Write E2PROM”. Note that, prior to initialization, this view shows a “blank” configuration.

![Smart View Configuration](image)

**Figure 25. TwinCAT “Smart View” Slave Properties Window Showing Blank Slave**

3. Click “Browse” to find the desired EEPROM binary associated with either the SPI or EMIF interface in the sw/master_files directory downloaded from the project site.
   (a) pdi_test_app_spi.bin – for SPI interface
   (b) pdi_test_app_emif.bin – for EMIF interface
   (c) Click “OK”.

![EEPROM File Dialog](image)

**Figure 26. TwinCAT3 EEPROM File Dialog**
4. After TwinCAT writes the EEPROM (in this case for the SPI), the following “Smart View” window showing a valid configuration with PDI Type = “SPI slave” should appear (see Figure 27).

![Figure 27. TwinCat "Smart View" Slave Properties Window Showing Programmed EEPROM](image)

5. The EtherCAT Slave controller is now prepared for communication to the MCU.

3 Getting Started Firmware

A software package (project pdi_hal_test_app) is included with this TI Design that contains a Code Composer Studio™ (CCS) project designed for the 'F2837x. The project should be imported into CCS v6.0 or later for building and uploading to the target board. Six build configurations are provided to enable use of RAM or Flash-based designs with two board types (ControlCARD and LaunchPad) and two PDI types (EMIF and SPI).

NOTE: For EtherCat Developers: The EtherCAT Technology Group (ETG) recommends membership for parties implementing EtherCAT in a machine or machine line. For additional information about EtherCAT and ETG membership, see the following links:
- EtherCAT Technology Group site: [https://www.ethercat.org](https://www.ethercat.org)
3.1 **PDI Test Project CCS Setup (project import)**

The PDI test application contains a Hardware Abstraction Layer (HAL) that handles all of the configuration details for the EMIF or SPI interface. This CCS6.x project also performs some simple Read/Write tests to verify correct functioning of communication with the ET1100 Slave controller.

The CCS project files for pdi_hal_test_app can be downloaded from the design directory at http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT. Once downloaded, import this project into CCS 6.0 or later using the procedure below:

1. File → Import… (an “Import” popup window appears).
2. Select “Code Composer Studio” → CCS Projects. Click “Next”.
3. Use “Select search-directory” and click “Browse” to find the pdi_hal_test_app source directory.
4. Select pdi_hal_test_app from the list of Discovered projects:
   (a) Leave the “Automatically import referenced projects” box checked.
   (b) Checking the box for “Copy projects into workspace” is optional.
   (c) Click “Finish”. The CCS project will appear in the project explorer window.

4 **Testing and Results**

The main purpose of this test is to demonstrate the usage of the PDI between the C28x processor and the ET1100 EtherCAT Slave Controller. The EtherCAT board is available as both a piggyback board for the F2837x controlCARD and a BoosterPack for use with TI LaunchPads. Both boards have identical hardware and differ only in the connectors used to attach them to their respective processor board.

![Figure 28. EtherCAT BoosterPack Test Setup](image)

The test setup in Figure 28 shows a C2000 LaunchPad with attached EtherCAT BoosterPack and two PCs. The left PC connects to the BoosterPack through a standard Ethernet cable connected to Port 0, and runs TwinCAT 3 software, which provides EtherCAT Master functionality. The right PC connects to the LaunchPad directly through the USB connector and runs the EtherCAT Hardware abstraction layer (HAL) software on the CCS6.x development environment. The HAL software in this example performs the following functions:

- Initialize the C28x hardware and the selected PDI interface (SPI or EMIF)
- Execute read/writes to the ET1100 User RAM
- Execute reads from ET1100 register space
The intent of this project is to demonstrate the usage of the PDI. Therefore, no EtherCAT stack is included in this demo.

Note that the HAL software supports both the SPI and EMIF as PDI interfaces. The user must choose the proper settings when building the project. Correct jumper settings on the BoosterPack are also required for proper operation. These settings are described in Section 2.3.

4.1 Running Simple ESC Interface Test on C28x

After downloading the software from the project directory at http://www.ti.com/tool/TIDM-DELFINO-ETHERCAT and importing the project into CCS, perform the following steps to exercise the PDI HAL:

1. Open the example project pdi_hal_test_app in CCS. The file pdi_test_appl.c has the main routine. The following code is of interest:

```c
77///
78/// Main
79///
80 void main()
81{
82 //Initialize C28x MCU and HAL interface
83 ESC_HWInit();
84
85 //setup PDI for test
86 ESC_setupPDIInterface();
87
88 while(1)
89 {
90 //Keep updating local RAM with ET1100 registers for debug
91 ESC_debugUpdateESCRegLogs();
92 DELAY_US(1000 * 500);
93 }
94
95}
```

Figure 29. CCS example project: pdi_hal_test_app
2. Right click on the project and set the desired active build configuration. Figure 30 shows the available configurations, which provides options for board types (LaunchPad and controlCARD plugin), program storage (FLASH and RAM), as well as interface type (EMIF, SPI-A, or SPI-C).

![Figure 30. EtherCAT HW Abstraction Layer Project](image-url)
For this example, choose build configuration (6_LAUNCHPAD_SPIA_RAM) by right clicking on the project name and selecting “Build Configuration” → Set Active → (6_LAUNCHPAD_SPIA_RAM).

Figure 31. CCS Project Build Configuration Management

Start TwinCAT3 on the EtherCAT Master PC as described in Section 2.2. Note that double clicking the EtherCAT slave node (“Box 2” in Figure 32) opens up a properties windows, from which the “Advanced Settings window” can be opened. This is used later in the demo.

Figure 32. TwinCAT3 Advanced Settings Dialog
3. Start the debugger and open the memory browser window as shown in Figure 33. The “escRegs” data array contains a list of ET1100 register addresses and values. These get updated in the \texttt{ESC\_debugUpdateESCRegLogs()} function.

NOTE: The ESC RUN LED will NOT be on during the memory tests, which is described in the following sections. For more information, see the ET1100 data sheet.

ESC RAM READ TEST

4. Open up the “advanced settings” window in TwinCAT3 and go to the memory browser at ESC Access $\rightarrow$ Memory and view Start Offset = 1000h as shown in Figure 34.
5. In CCS, view the Expressions window and add "escRegs" as a watched expression. Note that, as data is entered into the window in TwinCAT, the values read on the CCS side are identical.

![Figure 35. EtherCAT Write to Memory From CCS Project](image)

**ESC RAM WRITE TEST**

6. Figure 36 shows program control after execution of the first 32-bit write and 32-bit read from PDI to ET100 address 0x1000.

![Figure 36. CCS Project Write to EtherCAT Slave](image)
7. The TwinCAT Master view of the ESC memory address showing the results of the write from CCS.

![Figure 37. TwinCAT3 Master Read of Data Written to EtherCAT Slave](image)

4.2 **TwinCAT3 Troubleshooting**

Common issues in TwinCAT3 usage:

- **Problem:** EtherCAT network fails to initialize
  - **Other Descriptions:** “Reload Devices” fails, “Scan” for devices fails, “Restart EtherCAT in config mode” fails.

- **Solutions:**
  - **Power Cycle the LaunchPad**
  - **Check to make sure a RealTime Ethernet Driver is available.**
    TwinCAT → “Show RealTime Ethernet Compatible Devices”. This opens a popup window below.
    - **Look for the first line “Installed and ready to use devices (realtime capable)”.**
      In this example, there are NO adapters installed!
    - **Select a compatible device; here it is “Local Area Connection → Intel ....” and click “Install”.**
    - **Close the window by clicking “X” in the upper right corner.**
Figure 38. TwinCAT3 Ethernet Adapter Installation
5 Design Files

5.1 Schematics
To download the schematics, see the design files at TIDM-DELFINO-ETHERCAT.

5.2 Bill of Materials
To download the bill of materials (BOM), see the design files at TIDM-DELFINO-ETHERCAT.

5.3 PCB Layout Recommendations

5.3.1 Layout Prints
To download the layer plots, see the design files at TIDM-DELFINO-ETHERCAT.

5.4 Altium Project
To download the Altium project files, see the design files at TIDM-DELFINO-ETHERCAT.

5.5 Gerber Files
To download the Gerber files, see the design files at TIDM-DELFINO-ETHERCAT.

5.6 Assembly Drawings
To download the assembly drawings, see the design files at TIDM-DELFINO-ETHERCAT.

6 Software Files
To download the software files, see the design files at TIDM-DELFINO-ETHERCAT.

7 References
1. LAUNCHXL-F28377S – C2000 Delfino MCU F28377S LaunchPad Development kit
2. TMDXDOCK28377D – F28377D Delfino MCU Experimenter Kit
3. Code Composer Studio (CCS) Integrated Development Environment (IDE)
4. Texas Instruments E2E™ online community: http://e2e.ti.com/

8 Terminology (Optional)
- EMIF: External Memory Interface
- ESC: EtherCAT Slave Controller
- ETG™: EtherCAT Technology Group
- LaunchPad: An easy-to-use development tool intended for MCU-based applications.
- MCU: MicroController
- PDI: Process Data Interface
- SPI: Serial Peripheral Interface
About the Author (Optional)

ROBERT LANDERS is a Systems Applications Engineer at Texas Instruments, where he is responsible for developing design solutions for the industrial drives segment. Robert earned his Master of Science in Electrical Engineering (MSEE) from the University of Texas Arlington. He is a member of the Institute of Electrical and Electronics Engineers (IEEE).

SANTOSH ATHURU is a Software Engineer at Texas Instruments, where he is responsible for TI C2000 embedded software applications. Santosh earned his Bachelors of Engineering (B.E) from the University of Madras, India. He is a member of the Institute of Electrical and Electronics Engineers (IEEE).
## Revision History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

<table>
<thead>
<tr>
<th>Changes from Original (April 2016) to A Revision</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Replaced TLK105 with DP83822 devices throughout the document.</td>
<td>1</td>
</tr>
<tr>
<td>• Updates were made to Section 1.1.</td>
<td>2</td>
</tr>
<tr>
<td>• Updates were made to Section 2.</td>
<td>10</td>
</tr>
<tr>
<td>• Updates were made to Section 2.3.</td>
<td>15</td>
</tr>
</tbody>
</table>
IMPORTANT NOTICE FOR TI REFERENCE DESIGNS

Texas Instruments Incorporated (‘TI’) reference designs are solely intended to assist designers (‘Designer(s)’) who are developing systems that incorporate TI products. TI has not conducted any testing other than that specifically described in the published documentation for a particular reference design.

TI’s provision of reference designs and any other technical, applications or design advice, quality characterization, reliability data or other information or services does not expand or otherwise alter TI’s applicable published warranties or warranty disclaimers for TI products, and no additional obligations or liabilities arise from TI providing such reference designs or other items.

TI reserves the right to make corrections, enhancements, improvements and other changes to its reference designs and other items. Designer understands and agrees that Designer remains responsible for using its independent analysis, evaluation and judgment in designing Designer’s systems and products, and has full and exclusive responsibility to assure the safety of its products and compliance of its products (and of all TI products used in or for such Designer’s products) with all applicable regulations, laws and other applicable requirements. Designer represents that, with respect to its applications, it has the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. Designer agrees that prior to using or distributing any systems that include TI products, Designer will thoroughly test such systems and the functionality of such TI products as used in such systems. Designer may not use any TI products in life-critical medical equipment unless authorized officers of the parties have executed a special contract specifically governing such use. Life-critical medical equipment is medical equipment where failure of such equipment would cause significant bodily injury or death (e.g., life support, pacemakers, defibrillators, heart pumps, neurostimulators, and implantables). Such equipment includes, without limitation, all medical devices identified by the U.S. Food and Drug Administration as Class III devices and equivalent classifications outside the U.S.

Designers are authorized to use, copy and modify any individual TI reference design only in connection with the development of end products that include the TI product(s) identified in that reference design. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of the reference design or other items described above may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

TI REFERENCE DESIGNS AND OTHER ITEMS DESCRIBED ABOVE ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY DESIGNERS AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS AS DESCRIBED IN A TI REFERENCE DESIGN OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TI's standard terms of sale for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm) apply to the sale of packaged integrated circuit products. Additional terms may apply to the use or sale of other types of TI products and services.

Designer will fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of Designer’s non-compliance with the terms and provisions of this Notice.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2016, Texas Instruments Incorporated